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Introducing Data Insight for Data Loss Prevention

About this guide
The Symantec Data Loss Prevention Data Insight Implementation Guide describes how Veritas Data Insight can be
integrated with Symantec Data Loss Prevention to locate and manage data at risk in your enterprise. This guide describes
how to connect the Enforce Server to the Data Insight Management Server, how to configure the Data Insight Lookup
Plug-in to retrieve pertinent data and populate incident attributes, and how to configure the risk score and time-frames to
report data at risk. This guide also describes how to configure Symantec Data Loss Prevention for use with the Veritas
Data Insight Self-Service Portal.

This guide does not address topics related to installing or configuring Veritas Data Insight (including the Self-Service
Portal), or topics involving Symantec Data Loss Prevention that are not specific to Veritas Data Insight integration with
Symantec Data Loss Prevention.

Where to get more information about Veritas Data Insight

Veritas Data Insight is sold and supported by Veritas. For more information about Veritas Data Insight, see https://
www.veritas.com/product/information-governance/data-insight.

About Data Insight
Many organizations struggle with identifying data users and owners for their unstructured data. This challenge is
compounded with the fact that organizations lack visibility into the types of content and data that is spread across their
computing environment.

With Veritas Data Insight, users can monitor file access to automatically identify the data user of a file based on the
access history. The usage information then automatically enters into the incident detail of files that violate Symantec Data
Loss Prevention policies. This method enables users to identify sensitive data along with the responsible users to enable
more efficient remediation and data management.

Veritas Data Insight scans unstructured data systems and collects the full access history of users across the data. Veritas
Data Insight helps organizations monitor and report on access to sensitive information.

Veritas Data Insight helps organizations solve the problem of identifying data owners and responsible parties for
information in spite of incomplete or inaccurate metadata or tracking information. This helps support large-scale business
owner-driven remediation processes and workflows.

What you can do with Veritas Data Insight and Symantec Data Loss Prevention

Veritas Data Insight can provide the following information:

• Who owns the data
• Who is responsible for remediation
• Who has seen the data
• Who has access to the data
• What data is most at risk
• Frequency of usage of data

The Veritas Data Insight information that contains the access history of data users is available to Symantec Data Loss
Prevention. If the access history on a file is recorded, a data user can be identified in a Network Discover incident.

The Folder Risk Report ranks folders based on number of files with policy violations, severity weightings, folder
exposure, and actual user accesses on sensitive data. This report provides a mechanism to focus on the folder assets
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with the largest volume of data and highest risk of data exposure. The report helps Symantec Data Loss Prevention
remediators drive down risk in the fastest possible manner.

Accessing reports of folders at risk

Symantec Data Loss Prevention queries Veritas Data Insight for the data user of a file and other access history attributes
like the last modifying user. This access history information is available in the Symantec Data Loss Prevention incident
snapshot as custom attributes.

The data user information from Veritas Data Insight can also be assigned to the Data Owner Name field, to enable the
automatic distribution of aggregated incident reports to data owners for remediation.

Creating and distributing aggregated incident reports to data owners

Data owners and custodians can remediate Symantec Data Loss Prevention Network Discover file-system and
SharePoint incidents directly using the Self-Service Portal in Veritas Data Insight. You can configure a workflow in
Veritas Data Insight to send email alerts to data owners or custodians about policy violations. They can then log in to the
Self-Service Portal to view the policy violations and remediate Symantec Data Loss Prevention incidents using Smart
Response rules.

About the Veritas Data Insight Self-Service Portal

Components of the Symantec Data Loss Prevention integration with
Veritas Data Insight
Veritas Data Insight monitors file access to automatically identify the data user of a file based on the access history. The
summary of access history information then automatically feeds into the incident detail of files that violate Symantec Data
Loss Prevention policies.

These components are integrated to provide data user information for the Network Discover incidents.

How Data Insight works with Data Loss Prevention

The following components are integrated to provide data user information for incident remediation.

Table 1: Data Insight integration components

Component Description

Veritas Data Insight Veritas Data Insight scans unstructured data systems (Network Attached Storage (NAS) filers,
Windows file servers, SharePoint). It reports on the access history of various users across files
and folders.
Using the Self-Service Portal provided by Veritas Data Insight, data owners and custodians can
remediate incidents directly, without needing access to the Symantec Data Loss Prevention
Enforce Server administration console.

Symantec Data Loss Prevention
Network Discover

Network Discover scans file shares on the unstructured data systems. It identifies confidential
information as Network Discover incidents.

Symantec Data Loss Prevention
Enforce Server

Symantec Data Loss Prevention queries Veritas Data Insight for the data user of a file and other
access history attributes like the last modifying user.
Symantec Data Loss Prevention provides users of the Veritas Data Insight Self-Service Portal with
the ability to view and execute incident remediation response rules.

How Data Insight works with Data Loss Prevention
Veritas Data Insight scans unstructured data systems and stores information about the access history across files and
folders.
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A Network Discover Server scans the files and folders in unstructured data systems to expose confidential data.
Information about the exposed confidential data is stored on the Symantec Data Loss Prevention Enforce Server. With the
activation of a license for Veritas Data Insight, a lookup plug-in on the Enforce Server pulls data user information from the
Veritas Data Insight Management Server. This data user information populates custom attributes for a Network Discover
incident at the time the incident is generated.

A process table specifies the installation and configuration of the required components.

Locating and managing data at risk

What you can do with Veritas Data Insight and Symantec Data Loss
Prevention
What you can do with Veritas Data Insight describes the use cases of Veritas Data Insight to enable more efficient incident
remediation. You use the Network Discover incident report options to identify the data owners to notify about these
incidents.

Finding data users and accesses in incident reports

Table 2: What you can do with Veritas Data Insight

Tasks Description

Prioritize remediation of folders. The Folder Risk Report ranks folders based on number of files with policy violations, severity
weightings, folder exposure, and actual user accesses on sensitive data. This report provides
a mechanism to focus on the folder assets with the largest volume of data and highest risk of
data exposure. The report helps Symantec Data Loss Prevention remediators drive down risk in
the fastest possible manner. The Folder Risk Report is only available for file system Discover
targets.

Create and automatically distribute
aggregated incident reports to data
owners for remediation.

Data-owner remediation reports provide a scalable method of remediating large numbers of
incidents. You can aggregate incidents into a single incident report for each data owner on an ad
hoc or scheduled basis and then email the remediation reports (as a CSV or HTML attachment)
to the respective custodians or data owners.

Identify the data owner. File owner information may not reflect the responsible party. The responsible party or data owner
can be a line manager in the business unit, the head of a department, or an information security
officer. Veritas Data Insight provides information to tie the most active user of a file to a manager
or responsible party for remediation steps.

Identify the next-best owner. The  Data Owner field may return an unresolvable account for an individual that has left the
organization. For example, in Windows Active Directory, every user has an underlying unique
identifier that is associated with their account. This identifier is sometimes an unidentifiable string
of information. Veritas Data Insight provides information to drop down to the next resolvable
account that names an individual.

Identify the data custodian. Veritas Data Insight enables assignment of one or more users as custodians of a data repository.
Custodian tagging is typically used to determine the person responsible for remediation.
The assigned custodian need not have accessed the files and folders. Support for custodian
information is available beginning with Veritas Data Insight version 4.0.

Investigate a data leak. In the event of a data leak, you may want to know who saw a particular file. You can run a
Symantec Data Loss Prevention summary report by the data user custom attribute. Also,
incident snapshots provide information to tie the incident back to the Veritas Data Insight
Management Server. On the Veritas Data Insight Management Server, you can view detailed
information and an audit history of who accessed the data. You can also view correlations to
similar incidents. Additional remediation steps can then be taken to report on those individuals or
launch subsequent targeted scans on their assets.
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Tasks Description

Create and automatically distribute
remediation workflows to data
owners and custodians.

The Veritas Data Insight Self-Service Portal allows you to distribute the remediation workflow
directly to data owners and custodians. The Self-Service Portal allows data owners and
custodians to view policy violations and apply Smart Response rules without requiring access
to the Symantec Data Loss Prevention Enforce Server administration console. The Self-Service
Portal is available beginning with Veritas Data Insight version 4.5.

Where to get more information about Veritas Data Insight
You must target a file share on a filer that is supported for both Veritas Data Insight and Symantec Data Loss Prevention.
The supported filers and supported client protocols (such as CIFS) are listed in the following documentation:

• Veritas Data Insight supports specific filers.
For a list of the supported filers, see the Veritas Data Insight Installation Guide.

• Network Discover scans of file systems support specific client protocols.
For a list of the supported client protocols, see Supported file share targets in the Help.

Veritas Data Insight only scans SharePoint Document and Picture Libraries.

The following documentation provides more information about Veritas Data Insight:

• Veritas Data Insight Installation Guide
Explains how to install Veritas Data Insight.

• Veritas Data Insight Administrator's Guide
Explains how to configure and administer Veritas Data Insight using the management console. Explains how to gather
the access history of the data users. Explains how to configure and customize the Self-Service Portal.

• Veritas Data Insight User's Guide
Explains the Veritas Data Insight views that display data access information on folders and by users or groups.
Explains how to set up Veritas Data Insight reports. Explains how to use the Self-Service Portal to remediate Symantec
Data Loss Prevention incidents.

The following documentation, available at the Symantec Data Loss Prevention Help Center,  provides information about
the setup to identify data users in the Symantec Data Loss Prevention product using the information from Veritas Data
Insight:

• Symantec Data Loss Prevention System Requirements Guide
Provides the requirements for the disk space for the Veritas Data Insight information on the Enforce Server.

• Symantec Data Loss Prevention Installation Guide
Explains how to install the Symantec Data Loss Prevention product.

• Symantec Data Loss Prevention Help
Explains how to configure and run the scan of a Network Discover Box cloud storage, file system, or SharePoint target,
and how to set up reports.
Explains how to configure other lookup plug-ins, including CSV, LDAP, and Script Lookup Plug-ins.
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Enabling Data Insight to manage risk

Locating and managing data at risk
To locate and manage data at risk using Veritas Data Insight, use the following processes:

• Set up, create, and automatically distribute aggregated incident reports to data owners for remediation.
Creating and distributing aggregated incident reports to data owners
Finding data users and accesses in incident reports

• Retrieve the data user from the Veritas Data Insight Management Server into the Data Owner Name field in Discover
incidents. Then use the Discover reports to locate and manage the incidents.
Configuring a Data Insight connection
Configuring the Data Insight lookup plug-in to retrieve data owner details from Data Insight

• Retrieve details about file use from the Veritas Data Insight Management Server into the custom attributes in the
Discover incidents, to provide additional fields in the Discover reports to locate and manage the incidents.
Configuring a Data Insight connection
Configuring the Data Insight lookup plug-in to retrieve custom attribute values from Data Insight

Implementing Data Insight for Data Loss Prevention to manage data at
risk
To set up the connection to the Veritas Data Insight Management Server, complete the following process:

Table 3: Configuring a Data Insight connection

Step Action Description

1 Install and configure the Veritas Data Insight
Management Server.

Make sure that the Veritas Data Insight Management
Server has access to the files or file systems of interest.
See the following Veritas Data Insight documentation:
• Veritas Data Insight Installation Guide
• Veritas Data Insight Administrator's Guide

2 Install and configure Symantec Data Loss
Prevention.

You must install and configure at least one Network
Discover Server. See the Symantec Data Loss Prevention
Installation Guide in Related Documents.

3 Configure a connection between the Enforce
Server and Veritas Data Insight.

Veritas Data Insight is a separately licensed option. If
Veritas Data Insight is not licensed on the Enforce Server,
the menu option to configure the connection to the Veritas
Data Insight Management Server does not appear.
If you add the Veritas Data Insight license onto an existing
Enforce Server, you must restart the Incident Persister
service to enable incident lookup.
Configuring the connection between the Enforce Server
and Data Insight

4 Test the connection to Veritas Data Insight. Verify the connection between the Enforce Server and the
Veritas Data Insight Management Server.
Troubleshooting the Data Insight lookup plug-in
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Step Action Description

5 Install and configure the Self-Service Portal. Install and configure the Self-Service Portal on the Veritas
Data Insight side.
See the following Veritas Data Insight documentation:
• Veritas Data Insight Administrator's Guide
Configure Symantec Data Loss Prevention for integration
with the Self-Service Portal.
About the Veritas Data Insight Self-Service Portal

To retrieve details about file use into the Data Owner Name field, first complete the setup in Configuring a Data Insight
connection, then complete the following steps:

Table 4: Configuring the Data Insight lookup plug-in to retrieve data owner details from Data Insight

Step Action Description

1 Configure the Data Insight lookup plug-in to retrieve
Data Owner details.

Configure the Data Insight lookup plug-in to retrieve the
Veritas Data Insight data user directly into the Data Owner
Name field in the Discover incidents.
Configuring Data Loss Prevention to retrieve attribute
values from Data Insight

2 Configure other lookup plug-ins to populate the
Data Owner Email field.

Configure other lookup plug-ins as necessary to set
the Data Owner Email Address field, or other custom
attributes.
You can chain the LDAP, the CSV, or Script lookup plug-
ins with the Data Insight lookup plug-in to set the Data
Owner Email Address field.
See Managing and configuring lookup plug-ins for details
on configuring these plug-ins.

3 Scan the file systems or SharePoint servers of
interest.

To set up a Network Discover scan of the file systems
or SharePoint servers of interest, see  About scans of
SharePoint servers.

4 Test the plug-ins. Test that the details from the Veritas Data Insight
Management Server populate the Data Owner Name
field.
View the incident reports to verify that the expected
information is present.
Finding data users and accesses in incident reports

To retrieve details from Veritas Data Insight about file use into custom attributes, complete the setup in Configuring a Data
Insight connection, then complete the following steps:
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Table 5: Configuring the Data Insight lookup plug-in to retrieve custom attribute values from Data Insight

Step Action Description

1 Create custom attributes. On the Enforce Server, create custom attributes for each
file detail that you want retrieved from the Veritas Data
Insight Management Server.
Introducing the Data Insight lookup plug-in
See Configuring custom attributes in Help for details on
configuring custom attributes.

2 Configure the Data Insight lookup plug-in and
others you want to implement.

Configure the Data Insight lookup plug-in as well as any
other lookup plug-ins you want to implement.
Configuring Data Loss Prevention to retrieve attribute
values from Data Insight
Refer to Managing and configuring lookup plugins in the
Help for details on configuring the CSV, LDAP, and Script
lookup plug-ins.

3 Map the attributes. Map the details from the Veritas Data Insight Management
Server to the custom attributes that you created.
Mapping attributes to Data Insight data fields

4 Scan the file systems, SharePoint servers, or Box
accounts you want to protect.

Set up a Network Discover/Cloud Storage Discover scan
of the file systems or SharePoint servers of interest.
Support for SharePoint targets is available with Veritas
Data Insight version 4.0 or later.
See About Discover scan details in Help for information
on  configuring Discover scans.

5 Test the plug-ins. Test that the details from the Veritas Data Insight
Management Server populate your custom attributes. View
the incident reports to verify that the expected information
is present.
Finding data users and accesses in incident reports

Configuring the connection between the Enforce Server and Data
Insight
Before you can use the information from Veritas Data Insight, you need to configure the connection to the Veritas Data
Insight Management Server.

You can also optionally configure the risk score and other options for the report of folders at risk. The risk score is based
on relevant information from the Symantec Data Loss Prevention incidents plus the information from the Veritas Data
Insight Management Server.

1. Click System > Settings > Data Insight from the Enforce Server administration console.

If Veritas Data Insight is not licensed on the Enforce Server, this menu option does not appear.

If you add the Veritas Data Insight license onto an existing Enforce Server, you must restart the Incident Persister
service to enable the Veritas Data Insight lookups and the data owner lookups for incidents.
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2. Click Configure.

3. Enter the Host Name of the Veritas Data Insight Management Server. The Host Name may need to match the host
name in the certificate.

4. Enter the Port number of the Veritas Data Insight Management Server. The default is 443.

5. Click Retrieve Certificate.

This retrieval sends a request to the specified Veritas Data Insight Management Server to obtain its SSL certificate.

6. Click Yes to trust the certificate.

Verify that the certificate is returned from the Veritas Data Insight Management Server and that is the correct
certificate.

7. Enter the log on information to the Veritas Data Insight Management Server.

• Select Use Saved Credentials to use a credential that is saved in the credential store.
Then enter the name of the saved credential.

• Select Use These Credentials to enter the credentials here.
• Enter the Username and Password, and Re-enter Password.

8. Click Test Connection to verify the connection to the Veritas Data Insight Management Server.

This tests the connection to the Veritas Data Insight Management Server using the specified credentials. This Test
Connection operation is available only after the server certificate is verified. If the test is successful, the system
displays the message: "The test connection succeeded." If the test is not successful, verify the connection parameters
and credentials.

9. Optionally, you can configure the risk score and timeframes for the report of folders at risk. Generally, the defaults are
acceptable.

Configuring the risk score and timeframes for the report of folders at risk

10. Optionally, you can also configure the data refresh schedule to retrieve the information from the Data Insight
Management Server.

Changing Data Insight refresh intervals

Introducing the Data Insight lookup plug-in
The Data Insight lookup plug-in pulls data from a Veritas Data Insight Management Server. It then uses that data to
populate custom attributes for a Network Discover incident at the time the incident is generated. The Data Insight lookup
plug-in connects Symantec Data Loss Prevention with Veritas Data Insight to retrieve attribute values. Data Insight can be
used to provide granular context to incidents, including up-to-date data owner information.

NOTE

The Data Insight lookup plug-in requires a Data Insight license separate from Symantec Data Loss Prevention
licensing. If your system is not licensed for Data Insight, the Data Insight lookup plug-in is not available.

About Data Insight

You must create custom attributes for each attribute you want populated from the Veritas Data Insight Management
Server. You create only the custom attributes that you need. When an incident is created, the Enforce Server retrieves
data regarding that incident. Some of that data is in the form of "attributes." Custom attributes capture and store
supplemental data that is related to the incident, such as the name of a relevant manager or department. See Configuring
custom attributes in Help.

To populate custom attributes with the incident-related data, the Enforce Server uses the Data Insight lookup plug-in to
retrieve the additional data from the Veritas Data Insight Management Server. You can chain the Data Insight lookup plug-
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in with other plug-ins, such as the LDAP lookup plug-in, CSV lookup plug-in, or Script lookup plug-in. For example, you
may want to do this to set the Data Owner Email Address field. If the new lookup returns null or empty values for any
custom attribute fields, those empty values overwrite the existing values.

The values for the custom attributes are updated by clicking Lookup in the Attribute section of the Incident Snapshot
screen. This action replaces the existing values that are stored in the custom attribute fields with the values returned by
the new lookup. See About lookup plug-ins in Help.

The Veritas Data Insight lookup plug-in can retrieve the following information from the Veritas Data Insight
Management Server:

• Data user. The data user is the user who most frequently accessed the file.
• Business owner as defined in the Veritas Data Insight product.
• Custodian. The custodian is the user who is responsible for remediation of the file. (Support for custodian information

is available with Veritas Data Insight version 4.0 or later.)
• Custodian Folder. The URI of the file system or SharePoint folder to which the custodian is assigned. (Support for

custodian folder information is available with Veritas Data Insight version 4.0 or later.)
• Data user last access time. The last time the data user accessed the file.
• Data user access count. The number of times the data user accessed the file.
• Most active users.
• Most active readers.
• Most active writers.
• Read and write counts for each of the most active users, readers, or writers.
• Last modified by.
• Last accessed time.
• Number of read accesses across all users.
• Number of write accesses across all users.
• The first time that access history was collected for this incident.

Configuring Data Loss Prevention to retrieve attribute values from Data Insight

Configuring Data Loss Prevention to retrieve attribute values from
Data Insight
The System > Incident Data > Lookup Plugins page in the Enforce Server administration console is where you
configure the Data Insight lookup plug-in. You can configure one Data Insight lookup plug-in per Enforce Server instance.

Table 6: Configuring the Data Insight lookup plug-in

Step Action Description

1 Create custom
attributes.

Configure attribute status values and create custom attributes at the System > Incident Data >
Attributes page.  See About incident status attributes in Help.

Note: If you use only the data-owner-name attribute, you do not have to create a custom
attribute. The data-owner-name attribute is generated by the system.

2 Configure a connection
to Data Insight.

Set the host name, credentials, and parameters to connect to Data Insight.
Configuring the connection between the Enforce Server and Data Insight

3 Create a new Data
Insight lookup plug-in.

From the Enforce Server administration console, navigate to the System > Incident Data >
Lookup Plugins page and select New Plugin > Data Insight.

4 Enter a Start Date. If you leave this field empty, the system sets this field to oldest date for history possible, which
is 1/1/1970.
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Step Action Description

5 Select the Active User
Count.

You can specify between 0 and 10 active users. The default is 1.

6 Select the Active
Reader Count.

You can specify between 0 and 10 active readers. The default is 1.

7 Select the Active
Writer Count.

You can specify between 0 and 10 active writers. The default is 1.

8 Configure the Attribute
Mapping.

The system provides you with an attribute mapping template for all the information exposed by
Data Insight. A separate entry is made for each custom attribute to be populated. You enter the
custom attribute to the right of the equals sign for each entry you want to map. For example,
Data_User=attr.data-owner-name which is configured for you.
Mapping attributes to Data Insight data fields

9 Enable the plug-in. Enabling the Data Insight lookup plug-in
If you deploy multiple plug-ins, chain them as well.
Chaining the Data Insight lookup plug-in

10 Enable the lookup
parameter keys.

For example, if you use the data-owner-name attribute, select the Incident key. You can
select more than one key, but since each attribute group is a separate hit against the Symantec
Data Loss Prevention database, you should only select those keys you need.
Enabling lookup plug-in parameter keys

11 Test and troubleshoot
the plug-in.

Testing the Data Insight lookup plug-in configuration
Troubleshooting the Data Insight lookup plug-in

Mapping attributes to Data Insight data fields
Custom attributes are mapped to Veritas Data Insight information with entries in the Attribute Mapping field for the Data
Insight lookup plug-in. Each mapping is entered on a separate line in the field. The order in which these mapping entries
appear in the field does not matter.

If you use the Data Insight lookup plug-in to retrieve the data owner, this attribute is mapped for you
(Data_User=attr.data-owner-name). You can also define a mapping for an arbitrary custom attribute that a subsequent
plug-in in the lookup plug-in chain uses. Thus, for all other data fields except data-owner-name, you need to create
custom attributes.

Introducing the Data Insight lookup plug-in

The syntax for Data Insight attribute mapping is as follows:

{{pn.Matrix}} property  = attr.Custom Attribute Name

  

Where:

• {{pn.Matrix}} property
The Veritas Data Insight property whose data value is returned to the Enforce Server. This value is used to populate
the custom attribute that is specified in the attribute mapping.

• Custom Attribute Name
The name of the custom attribute as it is defined in the Enforce Server.

NOTE

If the name of the attribute contains white-space characters, you must precede each instance of the white
space with a backslash. A white-space character is a space or a tab. For example, you need to enter the
Total Writes custom attribute as: attr.Total\ Writes.

Here are some additional mapping examples:

 13
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File_Total_Writes = attr.Total\ Writes

File_Total_Reads = attr.Total\ Reads

File_Total_Writes = attr.Total\ Writes

File_Last_Modified_By = attr.Last\ Modified\ By

File_Last_Access_Date = attr.Last\ Accessed

All dates are in the YYYY-MM-DD hh:mm format (ISO 8601). The date is displayed in the time zone of the Enforce Server.

All names and users are in the format domain\username.

The following table describes the attribute mapping details for the Data Insight lookup plug-in.

NOTE

For more than two users, replace "n" with the user number. For example, enter Most_Active_Reader_3.

Table 7: Data Insight attribute mappings

Attribute Description

Data_User Attribute that corresponds to the data user. This person uses the file most frequently. The person
who uses the file most frequently may not be the person who created the file.

Business_Owner Custom attribute that corresponds to the business owner of the data user as defined in the Veritas
Data Insight Management Server.

Custodian_1 Custom attribute that corresponds to the remediator of the file. (Support for custodian information
is available with Veritas Data Insight version 4.0 or later.)

Custodian_Folder_1 Custom attribute that corresponds to the URI of the file system or SharePoint folder to which the
custodian is assigned. (Support for custodian folder information is available with Veritas Data
Insight version 4.0 or later.)

Data_User_Last_Access Custom attribute that corresponds to the last time that the data user accessed a file. The format is
YYYY-MM-DD hh:mm UTC+/-hh.

Data_User_Reads Custom attributes that correspond to the read access count of the data user.
Data_User_Writes Custom attributes that correspond to the write access count of the data user.
File_Access_History_Start_Date Custom attribute that corresponds to the first time that access history for the file was collected.
File_Last_Access_Date Custom attribute that corresponds to the last time the file was accessed.
File_Last_Modified_By Custom attribute that corresponds to the last user who modified the file.
File_Total_Reads Custom attribute that corresponds to the total number of read accesses.
File_Total_Writes Custom attribute that corresponds to the total number of write accesses.
Most_Active_Reader_1
Most_Active_Reader_2
Most_Active_Reader_n

Custom attributes that correspond to the most active readers. You can add any number of active
readers to the mapping.

Most_Active_Reader_Reads_1
Most_Active_Reader_Reads_2
Most_Active_Reader_Reads_n

Number of reads from the most active readers. You can add any number of active readers to the
mapping.

Most_Active_Reader_Writes_1
Most_Active_Reader_Writes_2
Most_Active_Reader_Writes_n

Number of writes from the most active readers. You can add any number of active readers to the
mapping.

Most_Active_User_1
Most_Active_User_2
Most_Active_User_n

Custom attributes that correspond to the most active user. You can add any number of active
readers to the mapping.
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Attribute Description

Most_Active_User_Reads_1
Most_Active_User_Reads_2
Most_Active_User_Reads_n

Number of reads from the most active users. You can add any number of active readers to the
mapping.

Most_Active_User_Writes_1
Most_Active_User_Writes_2
Most_Active_User_Writes_n

Number of writes from the most active users. You can add any number of active readers to the
mapping.

Most_Active_Writer_1
Most_Active_Writer_2
Most_Active_Writer_n

Custom attributes that correspond to the most active writers. You can add any number of active
readers to the mapping.

Most_Active_Writer_Reads_1
Most_Active_Writer_Reads_2
Most_Active_Writer_Reads_n

Number of reads from the most active writers. You can add any number of active readers to the
mapping.

Most_Active_Writer_Writes_1
Most_Active_Writer_Writes_2
Most_Active_Writer_Writes_n

Number of writes from the most active writers. You can add any number of active readers to the
mapping.

Enabling the Data Insight lookup plug-in
To deploy the Data Insight lookup plug-in you must enable it.

To enable the Data Insight lookup plug-in
1. Navigate to System > Incident Data > Lookup Plugins in the Enforce Server administration console.

2. Click Modify Plugin Chain at the Lookup Plugins List Page.

3. In the Dedicated Actions field, select (check) the On option.

4. Click Save to apply the configuration.

If the plug-in cannot be loaded the system reports an error and the plug-in state remains Off.

Chaining the Data Insight lookup plug-in
The Veritas Data Insight lookup plug-in can be used in combination with other types of lookup plug-ins. When multiple
lookup plug-ins are chained together, output from a previous lookup plug-in can be used as a key to retrieve additional
information.

The Data Insight lookup plug-in can be used in combination with other Data Loss Prevention lookup plug-ins. This is
known as "chaining." When multiple lookup plug-ins are chained together, output from a previous lookup plug-in is used
as a key to retrieve additional information. For example, commonly Data Insight is used to populate the data-owner-name
attribute. Another lookup plug-in, such as the LDAP lookup plug-in, is then chained to look up the data-owner-email value
which is based on the data-owner-name value. As another example, the Veritas Data Insight lookup plug-in provides the
most active user as a custom attribute in the Incident Snapshot. Another lookup plug-in (such as the LDAP lookup plug-
in ) can then retrieve related information for that user, such as the department or the manager's email.

See Chaining lookup plug-ins in the Help.

To chain the Data Insight lookup plug-in
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1. Navigate to System > Incident Data > Lookup Plugins in the Enforce Server administration console.

2. Click Modify Plugin Chain at the Lookup Plugins List Page.

3. In the Execution Sequence field, select the execution order from the drop-down menu.

4. Click Save to apply the chaining configuration.

Enabling lookup plug-in parameter keys
The System > Incident Data > Lookup Plugins > Edit Lookup Plugin Parameters page lists the Lookup Parameter
Keys that you select to trigger the look up of attribute values. Lookup parameter keys are organized into attribute groups.
The selections made at this screen apply to all the lookup plug-ins deployed on the Enforce Server.

To perform a lookup, you must map at least one lookup parameter key to a field in your external data source. Each lookup
parameter group that you enable is a separate database query for the Enforce Server to perform. All database queries are
executed for each incident before lookup. To avoid the performance impact of unnecessary database queries, you should
only enable attribute groups that your lookup plug-ins require.

Because the plug-in stops searching after it finds the first matching lookup parameter key-value pair, the order in which
you list the keys in your attribute map is significant. Refer to the attribute mapping examples for the specific type of plug-in
you implement for details.

NOTE

Refer to Enabling lookup plug-in parameter keys in Help for details on lookup plug-in parameter keys

To enable one or more lookup parameter keys
1. Navigate to System > Incident Data > Lookup Plugins in the Enforce Server administration console.

2. Click Lookup Parameters at the Lookup Plugins List Page.

3. Select (check) one or more attribute groups at the Edit Lookup Plugin Parameters page.

Click View Properties to view all of the keys for that attribute group.

Lookup parameter keys

4. Save the configuration.

Verify the success message indicating that all enabled plug-ins were reloaded.

Table 8: Lookup parameter keys

Attribute group Lookup parameter keys

Attachment attachment-nameX, attachment-sizeX

Incident date-detected, incident-id, protocol, data-owner-name, data-owner-email

Message date-sent, subject, file-create-date, file-access-date, file-created-by, file-
modified-by, file-owner, discover-content-root-path, discover-location, discover-
name, discover-extraction-date, discover-server, discover-notes-database, discover-
notes-url, endpoint-volume-name, endpoint-dos-volume-name, endpoint-application-
name, endpoint-application-path, endpoint-file-name, endpoint-file-path

Policy policy-name

Recipient recipient-emailX, recipient-ipX, recipient-urlX

Sender sender-email, sender-ip, sender-port, endpoint-user-name, endpoint-machine-name

Server server-name

Monitor monitor-name, monitor-host, monitor-id
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Attribute group Lookup parameter keys

Status incident-status

ACL acl-principalX, acl-typeX, acl-grant-or-denyX, acl-permissionX

Testing the Data Insight lookup plug-in configuration
Follow these steps to test the Data Insight lookup plug-in.

Table 9: Testing the Data Insight lookup plug-in

Step Action Description

1 Create a file share
Discover Target.

Set up the Discover Target to scan a Data Insight file share.
Configuring scans of file systems

2 Create a test policy. For example, you can create a keyword policy that uses the word "secret" as the keyword.
Configuring policies

4 Run the Discover
Target.

5 Verify attribute
lookup.

Check the Incident Snapshot for the Discover incident. Verify that for any attributes you mapped,
you should see that they are populated. For example, if you mapped the data-owner-name
attribute, you should that the Data Owner Name field is populated.

6 Troubleshoot
the plug-in as
necessary.

To troubleshoot, check the log file SymantecDLP\Protect\logs\tomcat
\localhost.latest_date.log.

Troubleshooting the Data Insight lookup plug-in
If the Data Insight lookup plug-in is not working, troubleshoot it as follows.

To test the connection to the Data Insight Management Server
1. Configure the connection from the Enforce Server to the Veritas Data Insight Management Server.

Configuring the connection between the Enforce Server and Data Insight

2. On the System > Settings > Data Insight page, click Test Connection to verify the connection to the Veritas Data
Insight Management Server.

This tests the connection to the specified Veritas Data Insight Management Server using the specified credentials. This
connection is available only after the server certificate is verified.

3. Configure and enable all the lookup plug-ins.

4. Click Reload Lookup Plugins to reload all the lookup plug-ins from the Custom Attributes tab of the System >
Incident Data > Attributes screen.

5. View an existing incident snapshot. Click the Lookup option on the incident snapshot.

6. Make sure that no connection errors are recorded in the Incident History section.

To verify that the custom attributes are correctly populated
7. Verify that the custom attributes have been created.

Select System > Incident Data > Attributes > Custom Attributes.

Verify that all the custom attributes exist in the list of custom attributes in the user interface.
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8. Click Reload Lookup Plugins to reload the plug-in from the Custom Attributes tab of the System > Incident Data >
Attributes screen.

9. Click the Lookup option for an existing Incident Snapshot.

10. When the page returns, view the Attributes area from the Incident Snapshot page.

• The Custom Attributes should be filled with entries retrieved from the Veritas Data Insight lookup.
• If the correct values are not populated, or there is no value in a custom attribute you have defined, check the

Tomcat log file for mismatched items.

To check the log files
11. Open the log file SymantecDLP\Protect\logs\tomcat\localhost.latest_date.log.

12. If the plug-in failed to load, search for a message in the log file similar to the following:

SEVERE [com.vontu.enforce.workflow.attributes.AttributeLookupLoader] Error loading plugin [Plugin_Name].

Note the "Cause" section that follows this type of error message. Any such entries explain why the plug-in failed to
load.

13. If the plug-in loads but attributes are not populated, look in the log for the attribute map. Verify that values are being
populated, including for the lookup parameters that you enabled. To do this, search for a lookup parameter key that
you have enabled, such as data-owner-name.

Changing Data Insight refresh intervals
To change the schedule for the data refresh from the Veritas Data Insight Management Server, update the properties in
the DataInsightDataRefresh.properties file on the Enforce Server.

The DataInsightDataRefresh.properties file is located in folder SymantecDLP\Protect\config in a default
Windows installation.

By default, the start time for the data refresh is daily at 1:00 A.M. If the data refresh does not finish by 7:00 A.M. (default),
then the data refresh process is interrupted and the reports are built. On the weekends, no cutoff is set by default, to allow
the data refresh process to complete over a weekend. The defaults are set to have the reports available at the start of
each work day.

If the start value is "none" then no data refresh starts on that day.

The following example contains data refresh start lines in the properties file:

data_refresh.start.sunday = none

data_refresh.start.monday = 1:00 AM

To specify no cutoff, set the value to "none" in the cutoff lines in the file.

The following example contains data refresh cutoff lines in the properties file:

data_refresh.cutoff.sunday = none

data_refresh.cutoff.monday = 7:00 AM

Best practices for finding and reporting on data at risk
The following best practices provide guidelines for implementation:

• Set up the Veritas Data Insight system and allow it to gather user information for a period of time.
See the Veritas Data Insight Administrator's Guide.
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Where to get more information about Veritas Data Insight
• Make sure that the Enforce Server is connected to the Veritas Data Insight Management Server.

Configuring the connection between the Enforce Server and Data Insight
• Configure your schedule to refresh the data from Veritas Data Insight to the Enforce Server.

Changing Data Insight refresh intervals
• Configure lookup plug-ins to look up and populate attributes in the Discover incidents. Lookup plug-ins can be scripted

and chained.
Managing and configuring lookup plug-ins
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Using Data Insight information in reports

Accessing reports of folders at risk
The Folder Risk Report helps information security analysts identify the top folders for investigation. Each folder is
assigned a risk score. The risk score is based on the relevant information from the Symantec Data Loss Prevention
incidents plus the information from the Veritas Data Insight Management Server. In the default display, the folders are
ranked with prioritized risk. The risk calculation is relative to the other folders in the list after the current filters are applied.
The highest risk folder always has a value of 100.

Some setup is required for all the information to appear in the report of folders at risk. Several options are also available to
configure the flow of information and parameters.

Configuring the risk score and timeframes for the report of folders at risk

To view the folders at risk
1. Click Incidents > Discover.

2. In the Discover Reports on the left side, click Folder Risk Report.
If the Folder Risk Report does not appear on the left side, verify that the role for your user name allows access.

Table 10: Folder Risk Report details

Information and Options Description

Filters Filtering the information in the report of folders at risk
Folders with risk score On the left is a list of folders with by the highest risk at the top.

Viewing folders ranked by risk, path, or folder exposure
Top Data Owners For the selected folder on the left, the top data owners are listed.

Viewing details of a folder at risk
The data owners in this report are from the Data Owner Name
field in the incident detail. Setup of a lookup plug-in, or a manual
process of setting this field, is required to place values into this
field. By default, this field does not have values.
Configuring Data Loss Prevention to retrieve attribute values from
Data Insight

Sensitive Files Access Trend For the selected folder on the left, the trend for the past 12 months
is listed.
Viewing details of a folder at risk
The number of days for this trend report can be configured.
Configuring the risk score and timeframes for the report of folders
at risk

User/Group Activity View For the selected folder on the left, all groups who have access to
the folder and their usage.
Viewing details of a folder at risk

For more information, see Saving a report of folders at risk and Locating and managing data at risk.
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Configuring the risk score and timeframes for the report of folders at
risk
You can configure the risk score for the report of folders at risk. The risk score is based on the relevant information from
the Symantec Data Loss Prevention incidents plus the information from the Veritas Data Insight Management Server. You
can also configure the timeframes that are in the details of the report.

To configure the risk score
1. Navigate to the System > Settings > Data Insight screen.

2. Click Configure.

3. Configure the risk score parameters as described in the following table.

Table 11: Folder risk report configuration options

Parameter Default Description

Access History Timeframe 365 The number of days in the timeframe for user access in the risk score formula.
Unique Users Timeframe 7 The number of days that is the timeframe for the user access in the formula.
Formula Severity and

folder exposure
Select one of the following choices for the components in the risk score
formula:
• Severity

The severity level of the incident in the Symantec Data Loss Prevention
incident report.

• Severity and folder exposure
Folder exposure is the number of users who can read from the folder
where the incidents were found.

• Severity, folder exposure and user access
User access is the number of users who have accessed the item at risk in
the past. The timeframe for the past is the number of days in the Unique
Users Timeframe parameter.

Weights (0-100): The severity weight of the item at risk. The maximum value of any weight is
100.

High Severity 100.0 Weight of a high severity item at risk.
Medium Severity 10.0 Weight of a medium severity item at risk.
Low Severity 2.0 Weight of a low severity item at risk.
Info Severity 1.0 Weight of an informational severity item at risk.

Viewing folders ranked by risk, path, or folder exposure
Click Incidents > Discover, and click the link to the Folder Risk Report.

In the list pane, you can view the folders at risk, and sort them by risk score, path, or folder exposure.

The risk score is based on the relevant information from the Symantec Data Loss Prevention incidents plus the
information from the Veritas Data Insight Management Server.

You can filter the information in the display by status, policy, location, and data owner.

Filtering the information in the report of folders at risk

A folder is not visible in the list pane if all its incidents are filtered out of the report.

If you click View Detail, detailed information for that folder appears in the detail pane.
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Viewing details of a folder at risk

You can use the arrow controls to jump to the first page, previous page, next page, or last page.

The following fields are visible in the list pane:

• The folder name and the full path of the folder.
• Top Policies by File Count

The top five policies that are violated and the number of files that are violated for each policy is listed in a chart, subject
to the filter criteria. The policies are listed in descending order by the number of sensitive files.
Click Incidents Summarized by Policy to open a new browser window or tab with the Symantec Data Loss
Prevention incident summary by policy. When you are finished viewing the information in the new browser window or
tab, then close it.

• Total Sensitive Files
The total sensitive files include all sensitive files in this folder, including those in the top five policies that are violated.

• Folder Exposure
The folder exposure is the number of users in the ACL that have read access to this folder.
See the details in the User/Group Activity View in the detail pane on the right side.
Viewing details of a folder at risk

To sort the folders at risk
1. To display the folders at risk, click Incidents > Discover. In the Discover Reports on the left side, click Folder Risk

Report.

2. In the Folder Risk Report, click one of the following items for the sort:

• Risk
This sort option is the default. The folders are listed with the most risk at the top.
The risk score is based on the relevant information from the Symantec Data Loss Prevention incidents plus the
information from the Veritas Data Insight Management Server.
You can configure the weights in the risk score formula.
Configuring the risk score and timeframes for the report of folders at risk

• Path
The folders are listed in alphabetical order.

• Folder Exposure
The folder exposure is a count of the number of users who have read access to the folder.
The folders are listed in descending order.

Viewing details of a folder at risk
The left detail pane provides details of the folders at risk.

The following related reports are links to details in a new browser window or tab:

• DLP: Folder Incident Report
The Folder Incident Report links to a new browser window or tab with the list of the Symantec Data Loss Prevention
incidents for the selected folder at risk.

• Data Insight: Top 5 Users
Data Insight: Monthly Access
Data Insight: Permissions
All of the Veritas Data Insight report links open a new browser window or tab to the Veritas Data Insight management
console.
You must log into theVeritas Data Insight management console before you can view these reports.
Where to get more information about Veritas Data Insight
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To view the details of a specific folder
1. To display the folders at risk, click Incidents > Discover. In the Discover Reports on the left side, click Folder Risk

Report.

2. For a folder in the list pane, click View Detail to show the details of that folder in the right pane.

The name of the folder is displayed at the top of the right pane.

The list pane (left) and details pane (right) have separate scrollbars, so that they can be positioned for the relevant
folder to be visible in each pane.

The right pane shows the following details of a folder at risk:

Table 12: Details of a folder at risk

Report detail Description

Top 5 Data Owners Top five sensitive file data owners, ranked by the number of sensitive files owned (if data owners
have been specified in the incidents).

Sensitive Files Access Trend Trend on a monthly basis over the past 12 months.
The time period can be configured, for a custom period.
Configuring the risk score and timeframes for the report of folders at risk
This table represents the number of unique users accessing sensitive files in the folder. The list is
broken down by month.

User/Group Activity View File activity of groups in the folder’s ACL.

Filtering the information in the report of folders at risk
To focus on specific folders at risk, you can filter the information in the report of folders at risk based on the status, policy,
location, and data owner.

To filter the information in the report of folders at risk
1. To display the folders at risk, click Incidents > Discover. In the Discover Reports on the left side, click Folder Risk

Report.

2. Click Edit Filters to open the list of filter options.

3. Select the filter options for your report.

Filters for the folder risk report lists the filter options.

4. At the bottom of the Filters window, click Apply Filters.

5. After you have a custom report that is set up with selected filters, you can save it.

Saving a report of folders at risk

The following filters can be set for the report of folders at risk:
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Table 13: Filters for the folder risk report

Filter Description

Incident Statuses Based on the status filters, individual incidents are filtered out of the data and the risk score, but the folder
is still visible. If all the incidents in a folder are filtered out, it is not visible.
To filter by incident status:
• Use the drop-down to select Include or Exclude. The remainder of the steps assumes that you have

selected Include which is the default.
• Select one of the status entries from the All Statuses list.
• Click the plus sign to move it to the Included Statuses list.
• Repeat for any other status entries to include.
• If you want to remove a status entry out of the Included Statuses, click the minus sign.
• You can search for a status entry by typing a string in the box underneath the Include label. Initially, this

box says "Search statuses."

Policies Based on the policy filters, individual incidents are filtered out of the data and the risk score, but the folder is
still visible. If all the incidents in a folder are filtered out, it is not visible.
To filter by policies:
• Use the drop-down to select Include or Exclude. The remainder of the steps assumes that you have

selected Include which is the default.
• Select one of the policies from the All Policies list.
• Click the plus sign to move it to the Included Policies list.
• Repeat for any other policies to include.
• If you want to remove a policy out of the Included Policies, click the minus sign.
• You can search for a policy by typing a string in the box underneath the Include label. Initially, this box

says "Search policies."

Locations The location filter selects the folders to include or exclude from the display. The risk score of a folder does
not change.
An Include section specifies the locations to include.
An Exclude section specifies the locations to exclude.
The method of selecting the locations to include or exclude is the same for both sections.
To filter by locations:
• Choose whether you want an Exact Match, Contains, or Starts with the string in the box.
• Enter a string in the box, which can be a full path or a partial path.
• Click the plus sign to move the selection to the list of locations to be included or excluded.
• If you want to remove a location entry out of the list, click the minus sign.

Data Owners The data owner filter selects the folders to include or exclude from the display. The risk score of a folder
does not change.

Note: If the folder contains other data owners, it remains in the report. An excluded data owner may appear
in the top data owners list.

An Include section specifies the data owners to include.
An Exclude section specifies the data owners to exclude.
The method of selecting the data owners to include or exclude is the same for both sections.
To filter by data owners:
• Choose whether you want an Exact Match, Contains, or Starts with the string in the box.
• Enter a string in the box.
• Click the plus sign to move the selection to the list of data owners to be included or excluded.
• If you want to remove a data owner entry out of the list, click the minus sign.
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Saving a report of folders at risk
After you filter a report, you can save it for continued use. When you save a customized report, Symantec Data Loss
Prevention displays the report title in Incidents > Discover under Saved Reports on the left side. If you choose to share
the report, Symantec Data Loss Prevention displays it for any user that is logged on under your role.

To save a custom report of folders at risk
1. Set up a customized report with a set of custom filters and optional sort order.

Filtering the information in the report of folders at risk

Viewing folders ranked by risk, path, or folder exposure

2. In the display of the report of folders at risk, click Save > Save As.

3. Enter a unique report name and describe the report. The report name can include up to 50 characters.

4. In the Sharing section, users other than the administrator can share a custom report.

NOTE

This section does not appear for the administrator.

The Sharing section lets you specify whether to keep the report private or share it with other role members. Role
members are other users who are assigned to the same role. To share the report, select Share Report. All role
members now have access to this report, and all can edit or delete the report. If your account is deleted from the
system, shared reports remain in the system. After a report is shared, sharing cannot be disabled for that report.
Shared reports are associated with the role, not with any specific user account. If you do not share a report, you are
the only user who can access it. If your account is deleted from the system, your private reports are deleted as well.

5. Click Save.

6. To edit a saved report, click Save > Save after you have edited the filters or changed the sort order.

7. To delete a saved report, click Delete.

Finding data users and accesses in incident reports
The Data Insight Lookup Plug-in populates the custom attributes that were defined and mapped during the configuration.

Introducing the Data Insight lookup plug-in

Mapping attributes to Data Insight data fields

The names of these custom attributes may be different in your configuration. General names for the custom attributes are
in the examples and explanation of possible reports in this section.

Use cases for reports shows use cases with suggestions for reports.
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Table 14: Use cases for reports

Use case Description Reports

Data owner File owner information may not
reflect the responsible party.
The responsible party or data
owner can be a line manager in
the business unit, the head of a
department, or an information
security officer. Veritas Data
Insight provides information to tie
the most active user of a file to a
manager or responsible party for
remediation steps.

Use the summary reports and filters to determine the incidents of interest.
Creating summary reports for Data Insight
The LDAP Lookup Plug-in, CSV Lookup Plug-in, or a Script Lookup Plug-in can
locate the manager or department of the file owner.
Enabling the Data Insight lookup plug-in
Use the incident snapshot report to determine the responsible party. Use the
Attributes section to view the information from the lookup plug-ins. Use the
attributes Lookup option to retrieve the information, if it is not present.
Viewing Data Insight incident details

Next-best
owner
identification

The File Owner field may return
an unresolvable account for
an individual that has left the
organization. For example, in
Windows Active Directory, every
user has an underlying unique
identifier that is associated with
their account. This identifier is
sometimes an unidentifiable string
of information. Veritas Data Insight
provides information to drop down
to the next resolvable account that
names an individual.
Veritas Data Insight provides
several data user fields.
Introducing the Data Insight lookup
plug-in

Use the summary reports and filters to determine the incidents of interest.
Creating summary reports for Data Insight
Use the incident snapshot report to determine the  File Owner. If that owner is
not identifiable, use the Attributes section to determine the next-best owner.
The Attributes section contains the information from the Veritas Data Insight
Management Server.
Viewing Data Insight incident details
Selecting custom attributes for data user details

Data leak
investigation

In the event of a data leak,
customers want to know who
saw a particular file. Symantec
Data Loss Prevention incident
snapshots provide information
to tie the incident back to the
Veritas Data Insight Management
Server. On the Veritas Data Insight
Management Server, you can view
detailed information and an audit
history of who accessed the data.
Additional remediation steps can
then be taken to report on those
individuals or launch subsequent
targeted scans on their assets.

Use the summary reports and filters to determine the incidents of interest.
Creating summary reports for Data Insight
Use the incident snapshot report to view details of an incident.
Viewing Data Insight incident details
Click the go to Data Insight option in the Incident Details section to view additional
details.
Accessing the history of a file in the Veritas Data Insight console
In the incident snapshot, click the Correlations tab to view a list of the incidents that
share attributes with the current incident.

Viewing Data Insight incident details
Symantec Data Loss Prevention incident lists display the individual incident records with information about the incidents.
You can click on any incident to see a snapshot containing more details. You can select specific incidents or groups of
incidents to modify or remediate.

To view incidents
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1. In the Enforce Server administration console, on the Incidents menu, select one of the types of reports. For example,
select Discover. In the left navigation panel, click Incidents-All Scans.

The incident list displays the individual incident records that contain information such as severity, associated policy,
number of matches, and status.

2. Optionally, use report filters to narrow down the incident list. Select the custom attributes from the Veritas Data Insight
Management Server to filter or summarize the incident list.

All custom attributes are all alphabetic fields. Sorting is alphabetic for the summary information for any custom
attribute. For example, in a summary of the read values, the value "15" comes after "1" and before "2." Numeric filters,
such as greater-than or less-than are not available for the custom attribute values that seem to be numbers or dates.

See About using custom attributes in Help.

3. To view more details of a particular incident, click the incident.

The incident snapshot appears, displaying general incident information, matches detected in the intercepted text, and
details about policy, attributes, and incident history. You can also search for similar incidents from the Correlations
tab.

4. Optionally, click through the incident snapshot to view more information about the incident.

The data user information from Veritas Data Insight is in the Attributes section.

5. When you finish viewing incidents, you can exit the incident snapshot or incident list, or you can choose one or more
incidents to remediate.

6. To view additional details about file access, you can jump directly to the Veritas Data Insight console.

Accessing the history of a file in the Veritas Data Insight console

Accessing the history of a file in the Veritas Data Insight console
To view additional details about file access, you can jump directly to the Veritas Data Insight console from a Symantec
Data Loss Prevention incident snapshot.

To view additional details about accesses for a particular file
1. Navigate to the incident snapshot for the file of interest.

2. In the Key Info tab, in the Incident Details section, File Location, click go to Data Insight console.

A browser screen opens with file access details for that particular file. The data user information includes an access
summary of the primary users of this file. The audit logs provide details about each access of the file, and a chart of
the access pattern.

For information about navigating in the Veritas Data Insight console, see the Veritas Data Insight Administrator's Guide.

Selecting custom attributes for data user details
You must define and configure a set of custom attributes before you can get information about data users.

Introducing the Data Insight lookup plug-in

Mapping attributes to Data Insight data fields

Initially, you can define the data user, the read count, write count, and one or two active readers and writers.

For a particular file of interest, the incident snapshot and Veritas Data Insight details provide the information to determine
who uses a file.
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For example, to determine the data users of a cluster of files, perform the suggested steps in the following procedure. If all
the files in a folder do not have appropriate access permissions, you can determine who has accessed those files.

To determine the data users of a cluster of files
1. Define a set of custom attributes for the Data Insight Lookup Plug-in.

Introducing the Data Insight lookup plug-in

Mapping attributes to Data Insight data fields

2. Set up and run a Network Discover scan of the folder of interest in the file share.
See Managing Network Discover/ Cloud Storage Discover Targets in Help.

3. After the scan has run, display the incident list. The File Owner is one of the columns. However, this field does not
provide the access pattern for these files.

4. You can select Advanced Filters & Summarization. Then run a summary by the Veritas Data Insight data user. This
summary lists the users who most frequently accessed the files in the folder of interest.

5. After an analysis of incidents, you can determine if additional custom attributes are needed from the information that
Veritas Data Insight provides. Then new custom attributes can be defined, configured, and looked up.

Introducing the Data Insight lookup plug-in

6. After you define any new custom attributes, click the Lookup option on the incident snapshot. Then make sure that no
connection errors are recorded in the Incident History section.

The values that appear in the incident snapshot Attributes section are the new ones.

Any deleted custom attributes and values are no longer present.

If the mapping of any custom attribute is changed and a new lookup is run, the new mapping overrides any old values
in the reports.

Creating summary reports for Data Insight
You can create a summary report for a summary of the data user activity for the files identified in an incident report.

To create a summary report from an incident list
1. In the Enforce Server administration console, on the Incidents menu, select one of the types of reports, and then click

an incident list. For example, select Discover, and then the report Incidents-All Scans.

2. Click the Advanced Filters & Summarization bar (near the top of the report).

In Summarize By section, a primary listbox and secondary listbox appear. Symantec Data Loss Prevention displays
all Symantec-provided criteria in alphabetical order. These criteria precede any custom criteria the administrator has
defined.

3. Select a criterion from the primary listbox, and an optional criterion from the secondary listbox. For example, select
the custom attribute for the Veritas Data Insight parameter for Data User and then Total Reads. This report shows the
read activity by user.

Options in the secondary listbox appear only after you choose an option from the primary listbox.

4. To create the summary report, click Apply.

Summary reports take their name from the primary summary criterion. If you rerun a report with new criteria, the report
name changes accordingly.

5. Save the report.
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Creating and distributing aggregated incident reports to data owners
You can create and automatically distribute aggregated incident reports to data owners for remediation.

An automatic workflow can be set up for the following use cases:

• Automatically or manually set the Data Owner Name and Data Owner Email Address for new incidents.
• Set a custom status value or custom attribute to mark that the Data Owner Name for an incident has been verified.

Custom attributes and custom status values can also mark incidents for other workflow steps.
• Set up a recurring email schedule.

Reports can be configured to be sent on a recurring schedule, sending only the incidents that have not yet been
distributed.

• Mark the incident as sent.
After the report is sent, the status attributes and custom attributes can optionally be set, to flag the incidents for the
next stage of the workflow.

• Automate the tasks.
Lookup plug-in scripts and chained lookup plug-ins can automate the tasks in the workflow sequence.

The following process describes a complex use case that includes the setup tasks, and suggestions to automate some
steps in the process.

Table 15: Setting up, creating, and distributing aggregated incident reports to data owners

Step Action Description

1 Install and set up the Veritas Data Insight
Management Server.
Make sure that the Veritas Data Insight
Management Server has access to the files or file
systems of interest.

See the following Veritas Data Insight documentation:
• Veritas Data Insight Installation Guide
• Veritas Data Insight Administrator's Guide

2 Install the Symantec Data Loss Prevention product,
including at least one Network Discover Server.

See the Symantec Data Loss Prevention Installation
Guide.

3 Set up the connection between the Enforce Server
and the Veritas Data Insight Management Server.

Configuring the connection between the Enforce Server
and Data Insight

Note: Veritas Data Insight is a separately licensed option.
If Veritas Data Insight is not licensed on the Enforce
Server, the menu option to configure the connection to the
Veritas Data Insight Management Server does not appear.

4 Test the connection from the Enforce Server to the
Veritas Data Insight Management Server.

Troubleshooting the Data Insight lookup plug-in

5 On the Enforce Server, create a custom status
value or custom attribute for the Data Owner Name
verification, and any workflow status attributes.

Introducing the Data Insight lookup plug-in

6 Map the details from the Veritas Data Insight
Management Server into the custom attributes that
you created.

Edit the properties file for Veritas Data Insight on the
Enforce Server, to map the details from the Veritas Data
Insight Management Server into the custom attributes that
you created.
Mapping attributes to Data Insight data fields

7 Map any of the Veritas Data Insight attributes
directly into the Data Owner Name field.

To map the Veritas Data Insight data user (the person who
uses the file most frequently) to the Data Owner Name,
set the Data_User parameter.
Configuring Data Loss Prevention to retrieve attribute
values from Data Insight
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Step Action Description

8 Set up all your lookup plug-ins. For example, you may want to chain the LDAP Lookup
Plug-in to take the Data Owner Name and set the Data
Owner Email Address as either the data owner or the
manager of the data owner.
No built-in capability provides consistency between the
data owner and email address. This action must be
customized.
The Data Owner Email Address can have multiple email
addresses that are separated with commas.

Note: If duplicate attribute names exist between these
names and custom attributes, then both fields are
updated.

Configuring Data Loss Prevention to retrieve attribute
values from Data Insight

9 Verify that the Enforce Server general settings are
set up to send email notifications.

Set up the SMTP notification settings.
Set the option Send report data with emails.

10 Verify that the incident responder has the privileges
to run the reports.

The Remediate Incidents privilege is required to
configure and run the reports.
The Lookup Attributes privilege is required to set
attributes from the lookup plug-ins.
The User Privilege CSV Attachment in Email Reports is
required to attach the CSV report to the email.

11 Set up a Network Discover and run a sample scan
of the file systems of interest.

12 Set up any custom reports. Set up a filtered report, or set up any report that you want
to distribute. For example, you can filter based on the new
incidents.
Select the option Change Incident Status / Attributes of
the reports scheduling to set incident status or attributes
when the email is sent.
You can also manually set the custom attribute that
indicates these incidents were verified. Select any or all
incidents in the list. Use the drop-down Incident Actions
and select Set Attributes. You can also set a custom
status from this drop-down menu.

13 Save the custom reports and set up a distribution
schedule.
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Working with the Veritas Data Insight Self-Service Portal

About the Veritas Data Insight Self-Service Portal
The Self-Service Portal allows your central information security team to distribute the Data Loss Prevention remediation
workflow directly to data owners and data custodians. Using the portal, data owners and custodians can take Network
Discover Box cloud storage, file-system, and SharePoint incident remediation actions at the file or the folder level without
needing access to the Enforce Server administration console. These remediation actions are Smart Response rules that
are executed by Symantec Data Loss Prevention on behalf of the Self-Service Portal user. For detailed information about
the configuration and use of the Self-Service Portal, see the Veritas Data Insight Administration Guide and the Veritas
Data Insight User Guide.

For detailed information about Smart Response rules, see About Smart Response rules in Help.

Symantec Data Loss Prevention provides two web services to Veritas Data Insight for incident remediation: the Response
Rule Listing Service and the Response Rule Execution Service. The Response Rule Listing Service provides a list of the
available response rules for a given incident, such as delete or quarantine. The Response Rule Execution Service takes
response rule requests from Veritas Data Insight and executes them in Symantec Data Loss Prevention. By default, the
Response Rule Execution Service is disabled. You must enable the service to allow Self-Service Portal users to remediate
incidents.

Configuring the Response Rule Execution Service

You can view the operational logs for the Response Rule Execution Service in the
responseruleservice_operational_0.log file within the SymantecDLP/Protect/logs directory. The
operational logs may be helpful for troubleshooting issues with the Veritas Data Insight Self-Service Portal.

Operational logs for the Response Rule Execution Service

Configuring Symantec Data Loss Prevention for use with the Veritas
Data Insight Self-Service Portal
Configuring Symantec Data Loss Prevention for use with the Veritas Data Insight Self-Service Portal involves the following
steps.

Table 16:

Step Action Description

1 If you have not already done so, configure Smart Response
rules for your Network Discover Box cloud storage, file-
system, and SharePoint incidents.

For detailed information about Smart Response rules, see the
Symantec Data Loss Prevention Administration Guide.

2 Create an Symantec Data Loss Prevention Enforce Server
user with the appropriate role-based access control
permissions for incident remediation.

Ensure that the user for the Self-Service Portal has Response
Rule Execution and Incident Update privileges for Discover
incidents, as well as Incident Modification privileges for the
incidents being remediated.
For detailed information about setting up users, including
configuring role-based access control, see Manage and add
roles and Manage and add users in the Help.
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Step Action Description

3 Configure the Response Rule Execution Service. By default, the Response Rule Execution Service is
disabled. To enable and configure the Response Rule
Execution Service, modify the appropriate parameters
in the SymantecDLP/Protect/config/
manager.properties file.
Configuring the Response Rule Execution Service

Configuring the Response Rule Execution Service
By default, the Response Rule Execution Service is disabled. To enable and configure the Response Rule Execution
Service, modify the appropriate parameters in the C:\Program Files\Symantec\DataLossPrevention
\EnforceServer\15.8\Protect\config\manager.properties file. After you have modified the parameters in
the manager.properties file, restart the SymantecDLP Manager service.

The only parameter you are required to configure is
com.vontu.enforcewebservices.responserules.execution.service.schedule. This parameter is set to
NEVER by default, which means that Symantec Data Loss Prevention never processes response rule requests from Veritas
Data Insight.

To schedule the Response Rule Execution Service, specify a start and end time in Quartz Cron format. The Quartz Cron
format differs from the standard Cron format slightly. For details about the Quartz Cron format, see the Quartz Scheduler
documentation.

Table 17: Configuration parameters for the Response Rule Execution Service

Parameter Default
value

Minimum
value Description

com.vontu.enforcewebservices.
responserules.execution.service.schedule

NEVER N/A Specifies the schedule on which Symantec
Data Loss Prevention executes response rule
requests from the Veritas Data Insight Self-
Service Portal. Possible values are:
• NEVER: Symantec Data Loss Prevention

Does not execute response rule requests
from the Veritas Data Insight Self-Service
Portal.

• ALWAYS: Symantec Data Loss Prevention
executes response rule requests from the
Veritas Data Insight Self-Service Portal
immediately upon receipt of the request.

• BY_SCHEDULE: Symantec Data Loss
Prevention executes response rules from
the Veritas Data Insight Self-Service Portal
according to the schedule specified in the
startHour and endHour parameters.

com.vontu.enforcewebservices.
responserules.execution.service.startHour

0 0 2 ? * * N/A Specifies the start time of the response rule
execution process in http://www.quartz-
scheduler.org/documentation/quartz-1.x/
tutorials/crontrigger format.

com.vontu.enforcewebservices.
responserules.execution.service.endHour

0 0 7 ? * * N/A Specifies the end time of the response rule
execution process in http://www.quartz-
scheduler.org/documentation/quartz-1.x/
tutorials/crontrigger format.
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Parameter Default
value

Minimum
value Description

com.vontu.enforcewebservices.
responserules.execution.request.
maxIncidentsInWaitingQueue

5,000,000 1 The maximum number of incidents held in the
waiting queue.

com.vontu.enforcewebservices.
responserules.execution.request. maxIncidentsPerRequest

10,000 1 The maximum number of incidents per
response rule execution request.

com.vontu.enforcewebservices.
responserules.execution.request. maxRequestQueueSize

10,000 1 The maximum number of response rule
execution requests held in the request queue.

Operational logs for the Response Rule Execution Service
The operational logs for the Response Rule Execution Service are useful for troubleshooting any issues you might
experience. All messages are logged at the INFO level, with the exception of RESPONSE_RULE_SERVICES_LOG_23, which is
logged at the FINE level.

You can set the Response Rule Execution Service operational log levels in the SymantecDLP/Protect/config/
ManagerLogging.properties file:

com.vontu.enforcewebservices. 

domain.responserules.logging.

ResponseRulesServicesLogHandler.level = INFO

Table 18:

Log code Log message Description

RESPONSE_RULE_SERVICES_LOG_1 The Response Rule
Request Processing Service
has started.

This message is logged when the service starts at
its scheduled time.

RESPONSE_RULE_SERVICES_LOG_2 The Response Rule
Request Processing Service
has stopped.

This message is logged when the service stops at
its scheduled time.

RESPONSE_RULE_SERVICES_LOG_3 Database connection is
lost while the service is
executing the requests. The
Response Rule Request
Processing Service will stop
processing the requests until
the database connection is
restored.

This message is logged if the database connection
is lost while the service is executing response
rules.

RESPONSE_RULE_SERVICES_LOG_4 Database connection is
lost. The Response Rule
Request Processing Service
will not process the requests
as per the schedule until
the database connection is
restored.

This message is logged if the database connection
is lost before the scheduled response rule
execution start time.

RESPONSE_RULE_SERVICES_LOG_5 Database connection is
restored. The Response
Rule Execution Request
Processing Service will start
processing the requests
now.

This message is logged if the database connection
is restored before the end of the scheduled
response rule execution period.
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Log code Log message Description

RESPONSE_RULE_SERVICES_LOG_6 Database connection is
restored. The Response
Rule Execution Request
Processing Service will start
processing the requests as
per the schedule.

This message is logged if the database connection
is restored before the response rule execution
service is started.

RESPONSE_RULE_SERVICES_LOG_7 The Response Rule
Execution Request
Processing Service has
shutdown.

This message is logged during the shutdown of
the service, usually as part of the SymantecDLP
Manager shutdown.

RESPONSE_RULE_SERVICES_LOG_8 Error encountered while
shutting down the Response
Rule Execution Request
Processing Service.
Reason: Error Message

This message is logged during the shutdown of the
service if an error occurs during shutdown.

RESPONSE_RULE_SERVICES_LOG_9 Database connection
is lost. The Response
Rule Execution Request
Processing Service will not
process the requests until
the database connection is
restored.

This message is logged during the scheduled start
of the service if the database connection is not
available.

RESPONSE_RULE_SERVICES_LOG_12 The new schedule mode
provided is invalid.
Execution schedule will not
be updated. Will remain with
current schedule type as
"NEVER".

This message is logged by the service if
the user an invalid value for the property
com.vontu.enforcewebservices.
responserules.execution.service.
schedule.

RESPONSE_RULE_SERVICES_LOG_13 The schedule mode
provided is invalid.
Execution schedule will be
set to default type "NEVER".

This message is logged by the service
during startup. The user entered
an invalid value for the property
com.vontu.enforcewebservices.
responserules.execution.service.
schedule.

RESPONSE_RULE_SERVICES_LOG_14 The Response Rules
Execution Request
Resource received a GET
request from the user
"USER" and IP address "IP
Address" and UUID "UUID"
with no RBAC permission for
response rule IDs [1,2].

The user does not have RBAC permissions for the
response rules provided in the request. Change
the user credentials to a user that has appropriate
permissions for the incidents. Returns a 403:
Forbidden HTTP status.

RESPONSE_RULE_SERVICES_LOG_15 The Response Rules
Execution Request
Resource received a BAD
request from the user
"USER" and IP address "IP
Address" and UUID "UUID".
Reason "Reason"

The user made the POST request with an invalid
set of parameters, causing a 400: Bad Request
HTTP return status. The Reason section explains
the cause of the problem. Possible reasons are
missing response rule IDs, non-existent response
rule IDs, missing incidents IDs, or invalid or
duplicate UUIDs
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Log code Log message Description

RESPONSE_RULE_SERVICES_LOG_16 The Response Rules
Execution Request
Resource received a POST
request from the user
"USER" and IP address "IP
Address" and UUID "UUID"
with no RBAC permission for
response rule IDs [1,2].

The user does not have RBAC permissions for the
incidents provided in the response rule ID. Change
the user credentials to a user that has appropriate
permissions for the incidents.

RESPONSE_RULE_SERVICES_LOG_19 Error encountered in
creating the Response
Rules Execution Request for
the POST request from the
user "USER" and IP address
"IP Address" and UUID
"UUID". Reason "Reason".

This message indicates that the service
encountered an error in creating the request. The
Reason section explains the cause of the error.

RESPONSE_RULE_SERVICES_LOG_21 The schedule mode is
changed from NEVER to
ALWAYS.

This message is logged by the service after the
service mode changed when the service was
running.

RESPONSE_RULE_SERVICES_LOG_23 The Response Rule with
ID "ID" is executed on the
incident with ID "ID" for the
Response Rule Execution
Request with the ID "ID"
as requested by the user
"USER".

This message is logged when the service has
run the response rule on the incident with ID
provided in the message. This message is logged
in verbose/fine mode only.
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